# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>OVERVIEW</td>
<td>1</td>
</tr>
<tr>
<td>SYSTEM REQUIREMENTS</td>
<td>1</td>
</tr>
<tr>
<td>- Is your operating system supported?</td>
<td>1</td>
</tr>
<tr>
<td>- Is your hardware supported?</td>
<td>1</td>
</tr>
<tr>
<td>LICENSING</td>
<td>2</td>
</tr>
<tr>
<td>- Receiver fails with “Remote sender could not obtain a valid license.”</td>
<td>2</td>
</tr>
<tr>
<td>NETWORKING</td>
<td>3</td>
</tr>
<tr>
<td>- Receiver fails with “Connection to [hostname/IP] could not be established.”</td>
<td>3</td>
</tr>
<tr>
<td>CONNECTION</td>
<td>3</td>
</tr>
<tr>
<td>- Receiver fails with “Connection to [hostname/IP] could not be established.”</td>
<td>3</td>
</tr>
<tr>
<td>VIDEO</td>
<td>3</td>
</tr>
<tr>
<td>- Sender display configuration fails to match local displays.</td>
<td>3</td>
</tr>
<tr>
<td>- Parts of the display are missing</td>
<td>4</td>
</tr>
<tr>
<td>- Frame rate is low.</td>
<td>4</td>
</tr>
<tr>
<td>- Image quality is poor, text is blurry</td>
<td>4</td>
</tr>
<tr>
<td>- No video is available to the TGX Receiver, the display is black</td>
<td>4</td>
</tr>
<tr>
<td>- No display connected to the Sender</td>
<td>5</td>
</tr>
<tr>
<td>- The receiver crashes if connected to a DisplayLink adapter.</td>
<td>5</td>
</tr>
<tr>
<td>- How do I use “Match My Desktop” if I am closing the display not connected to the DisplayLink adapter?</td>
<td>5</td>
</tr>
<tr>
<td>- TGX won’t match or configure my Mosaic display system</td>
<td>5</td>
</tr>
<tr>
<td>AUDIO</td>
<td>5</td>
</tr>
<tr>
<td>- No audio is available to the TGX Receiver</td>
<td>5</td>
</tr>
<tr>
<td>- Audio skips and crackles</td>
<td>6</td>
</tr>
<tr>
<td>- Receiver audio fails after ~15 minutes in Windows 10</td>
<td>6</td>
</tr>
<tr>
<td>WINDOWS SENDER</td>
<td>6</td>
</tr>
<tr>
<td>- Mouse does not map to the proper location on the remote desktop</td>
<td>6</td>
</tr>
<tr>
<td>- Restart TGX service</td>
<td>6</td>
</tr>
<tr>
<td>- TGX fails on a Sender with an integrated Intel GPU and NVIDIA GTX</td>
<td>7</td>
</tr>
<tr>
<td>- Mouse cursor isn’t updating</td>
<td>7</td>
</tr>
<tr>
<td>WINDOWS RECEIVER</td>
<td>7</td>
</tr>
<tr>
<td>- TGX receiver fails with an ATI graphics card</td>
<td>7</td>
</tr>
<tr>
<td>- Disconnect dialog is hidden behind the main window</td>
<td>7</td>
</tr>
<tr>
<td>LINUX SENDER</td>
<td>7</td>
</tr>
<tr>
<td>- Disable X start on boot</td>
<td>7</td>
</tr>
<tr>
<td>- SELinux issues</td>
<td>8</td>
</tr>
<tr>
<td>- Restart TGX service and X</td>
<td>8</td>
</tr>
<tr>
<td>- Reinstall TGX</td>
<td>8</td>
</tr>
</tbody>
</table>

April 10, 2018
<table>
<thead>
<tr>
<th>Troubleshooting Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>April 10, 2018</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Issue</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>TGX fails after logging in to Gnome (RHEL/CentOS 7)</td>
<td>8</td>
</tr>
<tr>
<td>NVIDIA GTX Sender has image tearing</td>
<td>8</td>
</tr>
<tr>
<td>Blank screen when connecting to Amazon AWS</td>
<td>9</td>
</tr>
<tr>
<td>Cloned a working VM with TGX and now it doesn’t work</td>
<td>9</td>
</tr>
<tr>
<td>Virtual Hardware/VGPU</td>
<td>9</td>
</tr>
<tr>
<td>Poor performance on some NVIDIA vGPU profiles</td>
<td>9</td>
</tr>
<tr>
<td>Only able to configure 1 display on NVIDIA Grid/TESLA pass-through hardware</td>
<td>9</td>
</tr>
<tr>
<td>USB Redirection</td>
<td>9</td>
</tr>
<tr>
<td>USB Sharing button doesn’t show up</td>
<td>9</td>
</tr>
<tr>
<td>USB devices won’t connect to Sender</td>
<td>10</td>
</tr>
<tr>
<td>USB devices don’t show up in sharing window</td>
<td>10</td>
</tr>
<tr>
<td>Debug Logs</td>
<td>10</td>
</tr>
<tr>
<td>Automated Log Collection</td>
<td>10</td>
</tr>
<tr>
<td>Manual Log Collection</td>
<td>11</td>
</tr>
<tr>
<td>Windows</td>
<td>11</td>
</tr>
<tr>
<td>Linux</td>
<td>11</td>
</tr>
<tr>
<td>OS X</td>
<td>11</td>
</tr>
<tr>
<td>Technical Support/Updated Documentation</td>
<td>12</td>
</tr>
<tr>
<td>Web</td>
<td>12</td>
</tr>
<tr>
<td>Email</td>
<td>12</td>
</tr>
<tr>
<td>Updated Documentation</td>
<td>12</td>
</tr>
</tbody>
</table>
## DOCUMENT REVISION HISTORY

<table>
<thead>
<tr>
<th>Version</th>
<th>Description of Changes</th>
<th>Author</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>Updated formatting; added “NVIDIA Grid pass through” and prior version exclusions.</td>
<td>C. Joyner</td>
<td>03/20/2017</td>
</tr>
<tr>
<td>1.1</td>
<td>Added “Mouse cursor isn’t updating”.</td>
<td>C. Joyner</td>
<td>03/22/2017</td>
</tr>
<tr>
<td>1.2</td>
<td>Added “No display connected to the sender” and other formatting.</td>
<td>C. Joyner</td>
<td>04/07/2017</td>
</tr>
<tr>
<td>1.3</td>
<td>Added “Disconnect dialog box”.</td>
<td>C. Joyner</td>
<td>05/30/2017</td>
</tr>
<tr>
<td>1.4</td>
<td>Added DisplayLink and TGX website link for 1.9 release.</td>
<td>C. Joyner</td>
<td>06/22/2017</td>
</tr>
<tr>
<td>1.5</td>
<td>Added USB Redirection troubleshooting steps for 1.9 release.</td>
<td>C. Twine/J.</td>
<td>07/03/2017</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Moder</td>
<td></td>
</tr>
<tr>
<td>1.6</td>
<td>Added Connection section.</td>
<td>C. Twine</td>
<td>07/26/2017</td>
</tr>
<tr>
<td>1.7</td>
<td>Added Mosaic and Amazon AWS information. Updated firewall port range.</td>
<td>J. Moder/C.</td>
<td>08/22/2017</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Twine</td>
<td></td>
</tr>
<tr>
<td>1.8</td>
<td>Updated table for supported hardware.</td>
<td>C. Twine</td>
<td>08/31/2017</td>
</tr>
<tr>
<td>1.9</td>
<td>Added Linux VM cloning information.</td>
<td>J. Moder/C.</td>
<td>10/02/2017</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Twine</td>
<td></td>
</tr>
<tr>
<td>1.10</td>
<td>Updated for 1.10 release.</td>
<td>J. Moder/C.</td>
<td>11/29/17</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Twine</td>
<td></td>
</tr>
<tr>
<td>1.11</td>
<td>Update Linux systemd commands.</td>
<td>J. Devan</td>
<td>4/10/2018</td>
</tr>
</tbody>
</table>
OVERVIEW

This document is intended to provide troubleshooting scenarios and solutions to aid in the use of TGX. The terms, Sender and Receiver are used throughout this document to identify the workstation in reference. The troubleshooting items in this document are applicable to all versions unless otherwise noted.

SYSTEM REQUIREMENTS

IS YOUR OPERATING SYSTEM SUPPORTED?

<table>
<thead>
<tr>
<th>TGX</th>
<th>Windows</th>
<th>Linux</th>
<th>OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>TGX Sender</td>
<td>7, 8, 8.1, 10, Server 2008R2, 2012</td>
<td>RHEL 6 &amp; 7, Ubuntu 16 and derivatives</td>
<td>Unsupported</td>
</tr>
<tr>
<td>TGX Receiver</td>
<td>7, 8, 8.1, 10</td>
<td>RHEL 6 &amp; 7, Ubuntu 16 and derivatives</td>
<td>El Capitan (10.11) and up</td>
</tr>
</tbody>
</table>

IS YOUR HARDWARE SUPPORTED?

<table>
<thead>
<tr>
<th>Windows</th>
<th>Graphics Card</th>
<th>Driver</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>TGX Sender</td>
<td>NVIDIA Quadro Kepler or better, NVIDIA GRID (pass-thru)</td>
<td>• R346 (minimum)</td>
<td>• 354.99 (recommended)</td>
</tr>
<tr>
<td></td>
<td>NVIDIA GRID (vGPU)</td>
<td>Latest available from NVIDIA website (recommended)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NVIDIA GTX</td>
<td>Latest available from NVIDIA website (recommended)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Intel HD, Iris, Iris Pro (Intel HD 4000 or newer)</td>
<td>XX.XX.XX.4352 or newer (December 23, 2015)</td>
<td></td>
</tr>
<tr>
<td>TGX Receiver</td>
<td>NVIDIA Quadro</td>
<td>• R346 (minimum)</td>
<td>• 354.99 (recommended)</td>
</tr>
<tr>
<td></td>
<td>NVIDIA GTX</td>
<td>Latest available from NVIDIA website (recommended)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Intel HD, Iris, Iris Pro (Intel HD 4000 or newer)</td>
<td>XX.XX.XX.4352 or newer (December 23, 2015)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>AMD (software decode)</td>
<td>14.301.1019 or newer (May 15, 2015)</td>
<td></td>
</tr>
</tbody>
</table>
### LICENSING

**RECEIVER FAILS WITH “REMOTE SENDER COULD NOT OBTAIN A VALID LICENSE.”**

The TGX Sender requires a valid license to function. Install a license file (e.g. TGX.lic) to the appropriate location in the table below. See the *TGX Install Guide* for more information on license installation.

<table>
<thead>
<tr>
<th>System</th>
<th>License Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>C:\ProgramData\Mechdyne\licenses</td>
</tr>
<tr>
<td>Linux</td>
<td>/opt/mechdyne/licenses</td>
</tr>
</tbody>
</table>

To set an alternative license file location, set the `LM_LICENSE_FILE` environment variable. On Windows, press the Windows key and type `System` to open the system control panel.

1. **Click** Advanced system settings
2. **Select** the Advanced tab
3. **Click** Environment Variables
4. **Add** a new variable under System Variables
5. **Restart** the TGX service (see *Windows Sender or Linux Sender section*)
NETWORKING

RECEIVER FAILS WITH “CONNECTION TO [HOSTNAME/IP] COULD NOT BE ESTABLISHED.”

- **Hostname/IP Address** – Ensure that the hostname or IP address is valid. Use a utility, such as ping, to verify that the machine is available (not all Windows variants will respond to a ping request).
- **VPN/Firewall** – Ensure that the VPN and/or firewall is properly configured; TGX requires access to ports 40001 – 40017 on the Sender machine.
- **SSL Setting** – This error can also be caused by an SSL setting mismatch between the Sender and Receiver. This configuration is uncommon since TGX will use SSL to encrypt all communications between the Sender and Receiver. However, this behavior can be disabled by a configuration file option on the Sender. If this setting is disabled on the Sender, then it must be disabled in the configuration file on the Receiver.

CONNECTION

RECEIVER FAILS WITH “CONNECTION TO [HOSTNAME/IP] COULD NOT BE ESTABLISHED.”

Ensure that the hostname or IP address is valid. Use a utility, such as ping, to verify that the machine is available (not all Windows variants will respond to a ping request). Contact your IT administrator for further assistance.

VIDEO

SENDER DISPLAY CONFIGURATION FAILS TO MATCH LOCAL DISPLAYS

Configuring the remote desktop to match local displays requires an NVIDIA Quadro, Tesla, or GRID graphics card with Quadro Sync and Mosaic mode disabled. Additionally, during the installation of the TGX Sender, the application must be configured to enable display configuration. If the Sender is supported by the graphics hardware, display configuration must be enabled.

- **During installation** – Click Yes to the message, *Allow TGX to overwrite the existing display configuration.*
- **Configuration file** – In `C:\ProgramData\Mechdyne\TGX\config.ini` or `/opt/mechdyne/TGX/etc/config.ini`, edit:

  ```ini
  [ServerSettings]
  HeadlessMode=true
  ```

- **TGX launcher** – Click on the caret to open the *Settings* panel and select a setting in the *Remote Displays* dropdown to match all or any one local display.
Linux Sender – A Linux Sender requires the user to logout (vs. disconnect) from a remote session in order to add displays to the session. For example, if a session is initiated with a single display, the user must logout and reconnect in order to configure two displays.

PARTS OF THE DISPLAY ARE MISSING

If parts of the display are missing when the resolution is changed through Windows display settings, use the NVIDIA Control Panel to set the display resolution. To correct an existing session:

1. Right-Click on the desktop
2. Select NVIDIA Control Panel
3. Select Adjust desktop size and position under the Display section
4. Select Full-screen as the scaling mode
5. Click Apply

FRAME RATE IS LOW

Optimal frame rate requires fast hardware on both the TGX sender and Receiver as well as a fast network connection.

- Network bottleneck – The required bandwidth can be reduced and framerate increased by lowering the requested image quality setting. In the TGX launcher, click the caret to expand the Settings panel.
- Hardware bottleneck – Reduce the number of requested displays and display resolution.
- Collaboration session – Framerate may be reduced to the lowest capability (either network or hardware-limited) among all collaborators. This ensures the best possible experience for all collaborators as a whole, though it may be less than optimal for any one user.

IMAGE QUALITY IS POOR, TEXT IS BLURRY

1. Disconnect from the session.
2. In the TGX launcher, click the caret to open the Settings panel.
3. Select a higher value on the Image Quality slider. Higher image quality requires higher bandwidth. The default setting of 68 provides a balance of image quality and bandwidth consumption that should be appropriate for most users.
4. On the TGX toolbar, select Full Resolution. If the remote desktop does not match the local displays, disconnect from the session.
5. On the TGX launcher, select a setting in the Remote Displays dropdown.

In a collaboration session, image quality may be reduced to the lowest setting among all collaborators. In this instance, all collaborators will need to increase the requested image quality setting.

NO VIDEO IS AVAILABLE TO THE TGX RECEIVER, THE DISPLAY IS BLACK

A black display with no video indicates that the desktop capture and encode paths failed on the TGX Sender. Ensure that the Sender meets the specifications outlined under the System Requirements section. Operating system specific troubleshooting information is available under the Windows Sender section.
and Linux Sender sections. Try connecting at alternative resolutions by changing the resolution of the Receiver display and selecting Match All Local Displays or Match Display #.

If you are unable to correct the situation, see the Debug Logs section to collect debug level logs and contact Technical Support.

**NO DISPLAY CONNECTED TO THE SENDER**

Navigate to the Settings menu from the TGX launcher. Ensure Use Remote Display As Is is not selected under the Remote Displays drop-down. Select any other matching option from this menu.

**THE RECEIVER CRASHES IF CONNECTED TO A DISPLAYLINK ADAPTER**

There must be an active display that is not connected to the DisplayLink adapter when launching TGX. Once connected, the display that is not connected to the DisplayLink adapter does not need to remain active. An active display is defined as a display that is viewable and not in any type of sleep or suspend mode.

**HOW DO I USE “MATCH MY DESKTOP” IF I AM CLOSING THE DISPLAY NOT CONNECTED TO THE DISPLAYLINK ADAPTER?**

- Matching only one display – select the specific display within the Remote Displays dropdown in the launcher.
- Matching more than one display – contact Mechdyne support for additional assistance.

**TGX WON’T MATCH OR CONFIGURE MY MOSAIC DISPLAY SYSTEM**

If using the TGX Receiver on a system with an NVIDIA Mosaic display system, TGX will not attempt to match displays even if “Match All Displays” is selected, due to the complexity of Mosaic displays. A connection file can be used to create displays of the desired size and orientation on the remote system. Contact Mechdyne support for connection file API information and additional assistance.

If using a TGX Sender on a system with an NVIDIA Mosaic display system, TGX will not attempt to reconfigure those displays even if asked to by a Receiver. It is recommended that the “Headless-mode” option, which enables display configuration, is turned off during installation to ensure TGX does not inadvertently break the Mosaic configuration.

**AUDIO**

**NO AUDIO IS AVAILABLE TO THE TGX RECEIVER**

Audio requires a Linux Sender (Version 1.8+ only) or a Windows Sender with a physical or virtualized sound card device. If the Sender supports audio, the volume and mute controls can be managed from the options menu on the TGX Toolbar from the Receiver. If the controls are not present, the Sender does not support audio.
If the Sender supports audio, check all volume and mute settings on the TGX Sender using the operating system volume mixer. Repeat for the TGX Receiver.

**AUDIO SKIPS AND CRACKLES**

Skipping or crackling audio is most likely caused by poor network performance (low bandwidth, high latency, high packet loss). TGX performs best over a high-speed wired connection. If network performance is not suspect, try rebooting the Sender machine.

To modify sound controls on the TGX Sender machine, navigate to the Windows sound control panel.

1. **Click** Playback devices
2. **Right Click** on the default device
3. **Select** Properties
4. **Click** the Advanced tab
5. **Change** the Default Format to 16 bit, 44100 Hz (CD Quality)
6. **Logout** and reconnect the TGX session

**RECEIVER AUDIO FAILS AFTER ~15 MINUTES IN WINDOWS 10**

From the Task Manager – Details tab, end the process tabtip.exe. A fix is in development.

**WINDOWS SENDER**

**MOUSE DOES NOT MAP TO THE PROPER LOCATION ON THE REMOTE DESKTOP**

If the mouse does not map to the proper location on the desktop, try restoring display scaling on the Sender to 100%.

1. **Right-click** on the desktop
2. **Select** Display Settings
3. **Select** a display
4. **Set** the Change the size of text, apps, and other items slider to 100%. Changing the display scaling may require logging out.

**RESTART TGX SERVICE**

If the TGX Sender is unresponsive, restart the TGXSessionService:

- Locally at the TGX Sender, press the Windows key and type Services to find the services control panel item. Select TGXSessionService and click Restart the Service.
- Using the Service Control Manager (sc), execute:
  
  ```
  sc \machine stop TGXSessionService
  sc \machine start TGXSessionService
  ```

  The Service Control Manager requires a domain account on the remote machine.
Using the Microsoft Management Console (mmc), select File → Add/Remove Snap-in..., select Services, click Add >, select Another Computer, enter the remote machine and click Finish. Select TGXSessionService and click Restart the Service. The Microsoft Management Console requires a domain account on the remote machine.

Using PsExec (available online), execute:

```
psexec \machine -u [user] -s net stop TGXSessionService
psexec \machine -u [user] -s net start TGXSessionService
```

**TGX FAILS ON A SENDER WITH AN INTEGRATED INTEL GPU AND NVIDIA GTX**

A Sender with an integrated Intel GPU and NVIDIA GTX card may fail if displays are connected to the Intel outputs. Update the NVIDIA GTX driver to 372.xx or newer.

**MOUSE CURSOR ISN’T UPDATING**

If there isn’t a virtual or physical mouse connected to the system, Windows does not always display a visual cursor. Most virtual machines are unaffected by this because the hypervisor provides a default mouse device. For systems without a virtual or physical mouse, enabling Mouse Keys in the Ease of Access menu or connecting a physical mouse to the system will display a cursor. The TGX software will compensate for this Windows setting in an upcoming release.

**WINDOWS RECEIVER**

**TGX RECEIVER FAILS WITH AN ATI GRAPHICS CARD**

TGX requires OpenGL 2.1 support which is unavailable on older ATI drivers. Upgrade the ATI driver to revision number 14.301.1019, released May 15, 2015, or newer.

**DISCONNECT DIALOG IS HIDDEN BEHIND THE MAIN WINDOW**

Alt + Tab will allow you to navigate to the disconnect dialog option. To permanently correct the issue, perform the following steps:

1. **Open** the NVIDIA Control Panel
2. **Select** 3D Settings
3. **Select** Manage 3D settings
4. **Select** Use block transfer in the drop-down menu for the Buffer-flipping mode.

**LINUX SENDER**

**DISABLE X START ON BOOT**

- For RHEL/CentOS 7 and Ubuntu 16, to permanently disable X start on boot, execute:
  
  ```
  # systemctl set-default multi-user
  ```

- For RHEL/CentOS 6, edit /etc/inittab.
For a server or VM with no displays attached, it is preferable to disable X start on boot.

### SELINUX ISSUES

X may fail to start if the SELinux properties on NVIDIA devices (/dev/nvidia*) are invalid. To restore the properties, run:

```
# restorecon -v /dev/nvidia*
```

The SELinux properties will reset to the invalid state on the next reboot. If this is a persistent issue, either add the restorecon command to the system startup scripts or disable SELinux. For RHEL/CentOS 7, SELinux can be disabled by editing `/etc/selinux/config`.

### RESTART TGX SERVICE AND X

If the TGX Sender is unresponsive, the service can be restarted over SSH with:

```
# systemctl restart tgxserverd  (RHEL/CentOS 7 and Ubuntu 16)
# /etc/init.d/tgxserverd restart  (RHEL/CentOS 6)
```

Defunct X sessions may be killed with `killall X` or `killall Xorg`.

### REINSTALL TGX

The TGX installer performs basic checks of the system’s NVIDIA driver, Xorg configuration and firewall state. If TGX fails to run, reinstalling the TGX Sender may identify the issue. If the TGX installer does not prompt to generate an Xorg configuration, remove or rename `/etc/X11/xorg.conf`.

### TGX FAILS AFTER LOGGING IN TO GNOME (RHEL/CENTOS 7)

If the TGX Sender is configured to not start a new X session for the connection, the user must log in at the display manager prompt. When Gnome 3 starts, gnome-shell reconfigures all displays to the default resolutions, which causes TGX to fail if alternative resolutions were requested. The two solutions are:

- Disable display configuration in the TGX Sender, installer, or configuration file
- Select *Use Remote Displays As Is* in the TGX launcher

### NVIDIA GTX SENDER HAS IMAGE TEARING

Disable OpenGL flipping in the NVIDIA settings manager:

1. **Open** the NVIDIA settings manager (`/usr/bin/nvidia-settings`)
2. **Select** the *OpenGL Settings* tab
3. **Disable** *Allow Flipping*

This installer will add this setting to `/etc/xorg.conf`, but a user level setting may override it.
BLANK SCREEN WHEN CONNECTING TO AMAZON AWS

TGX requires some extra configuration when running in the Amazon AWS cloud. Edit the TGX config.ini file (/opt/mechdyne/TGX/etc/config.ini) and add the line DisplayPrefix="VGA" in the [ServerSettings] section.

After this change has been made, restart the instance and TGX should function normally.

CLONED A WORKING VM WITH TGX AND NOW IT DOESN'T WORK

This may be a result of an X Server configuration issue where the graphics card may no longer enumerate the same on the new VM. The best solution is to reinstall TGX, so that the installer runs nvidia-xconfig and generates a functional xorg.conf. Advanced users may choose to manually edit the xorg.conf file and update the BusID field in the [Device] section.

VIRTUAL HARDWARE/VGPU

POOR PERFORMANCE ON SOME NVIDIA VGPU PROFILES

Certain NVIDIA vGPU profiles have less than 512 megabytes of frame buffer memory and are unable to access the hardware encoder. TGX will not perform well on these profiles:

- Tesla M6-0B, M6-0Q
- Tesla M10-0B, M10-0Q
- Tesla M60-0B, M60-0Q
- GRID K100, K120Q
- GRID K200, K220Q

ONLY ABLE TO CONFIGURE 1 DISPLAY ON NVIDIA GRID/TESLA PASS-THROUGH HARDWARE

NVIDIA GRID/TESLA products require licensing, even in pass-through. See Chapter 3 of the NVIDIA GRID Licensing Guide.

Without licensing, GRID/TESLA cards are only allowed one display output at 2560x1600. Once properly licensed, four outputs at 3840x2160 are available.

USB REDIRECTION

USB SHARING BUTTON DOESN'T SHOW UP

This indicates an issue with the USB configuration on either the Sender or Receiver. Follow the troubleshooting steps below to locate and correct the issue. Once the issue is resolved, the remaining steps are not required.
1. **Sender**: verify that the configuration file has the following:
   
   ```
   [ServerSettings]EnableUsb=true
   [Install]SetupUsb=true
   ```

2. **Receiver**: verify that the configuration file has the following:

   ```
   [ClientSettings]EnableUsb=true
   [Install]SetupUsb=true
   ```

3. **Sender and Receiver**: verify that the UsbService is running:
   
   a. Open Task Manager
   b. Select the Services Tab
   c. Verify the UsbService status is Running
      
      - If the UsbService is not in the list, reinstall the Sender or Receiver as applicable.
      - If the UsbService is in the list, but indicates that it stopped, restart the system.

4. Uninstall and re-install the Sender and Receiver.
   
   - Reboot the system after the uninstall, before the re-install.
   - Reboot the system, again, after the re-install is complete.

5. If it still is not functioning, collect the debug logs and contact Mechdyne software support for assistance.

### USB DEVICES WON'T CONNECT TO SENDER

1. Uninstall and re-install the Sender and Receiver.
   
   - Reboot the system after the uninstall, before the re-install.
   - Reboot the system, again, after the re-install is complete.

2. If it still is not functioning, collect the debug logs and contact Mechdyne software support for assistance.

### USB DEVICES DON'T SHOW UP IN SHARING WINDOW

1. Verify that the device isn't restricted based on the security policies of the Sender. See the Windows Install Guide for more information on configuring USB redirection on the Sender.

2. Try a different USB port/hub if possible.

3. If it still is not functioning, collect debug logs and contact Mechdyne software support for assistance.

### DEBUG LOGS

#### AUTOMATED LOG COLLECTION

Before contacting technical support, please generate debug level logs for both the TGX Sender and Receiver to aid in troubleshooting efforts.

1. **Select** `Enable Debug Logging` from the Help menu in the TGX connection window

2. **Start** a TGX session
3. **Reproduce** the issue if possible
4. **End** the session
5. **Select Get Logs** from the Help menu in the TGX connection window (Version 1.7.1+). See the *TGX User Guide* for more information.

If the Enable Debug Logging or Get Logs function does not work as described in the *TGX User Guide*, or for versions prior to 1.7.1, the following manual process can be used to complete this function.

**MANUAL LOG COLLECTION**

**WINDOWS**

To set the logging level to debug, navigate to `C:\ProgramData\Mechdyne\TGX\config.ini` (requires elevated privileges). Under the *DefaultSettings* section, add `LogLevel=DEBUG`.

1. On the TGX Sender, press the Windows key and type *Services* to find the services control panel item. Select TGXSessionService and click *Restart the Service*.
2. Connect with TGX to replicate the failure.
3. Under Windows Explorer, navigate to `C:\ProgramData\Mechdyne\TGX\logs`, select all files in the directory, right-click and select *Send to → Compressed (zipped) folder*.
4. To restore the normal log level, remove the `LogLevel=DEBUG` line from the *config.ini* file.

**LINUX**

The Linux Sender and Receiver include a shell script to easily collect log files.

1. To clear all old logs and set the logging level to debug, execute:
   ```bash
   # /opt/mechdyne/TGX/Sender/bin64/tgx_debug.sh -dl DEBUG
   ```
2. Replace *Sender* with *Receiver* as appropriate.
3. Connect with TGX to replicate the failure.
4. To reset the logging level and generate a tarball of all TGX logs with a system information dump, execute:
   ```bash
   # /opt/mechdyne/TGX/Sender/bin64/tgx_debug.sh -rt logs.tgz
   ```

**OS X**

1. To enable debug logs, edit `/Library/Application Support/com.mechdyne.TGX/config.ini` (requires elevated privileges) and under the *DefaultSettings* section, add `LogLevel=DEBUG`.
2. Connect with TGX to replicate the failure.
3. From a terminal window, execute:
   ```bash
   # zip logs.zip /tmp/TGXReceiver*
   ```
4. To restore the normal log level, remove the `LogLevel=DEBUG` line from the *config.ini* file.
Mechdyne is available for additional technical support. Please submit queries through our support portal on the web.

**WEB**

http://www.mechdyne.com/software-support.aspx

**EMAIL**

software_support@mechdyne.com

**UPDATED DOCUMENTATION**

Refer to the [TGX](http://www.mechdyne.com/software-support.aspx) website for the most updated documentation.